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Introduction

1 ANT-20 NEXT software

The “ANT-20 NEXT” software (ANT-20 Network Expert Test) makes it easy for even 
inexperienced users to commission or troubleshoot communications lines. The “ANT-20 NEXT” 
software can be run as an alternative to the standard graphical user interface of the ANT-20.

All you need to do to perform a measurement is select the type of path to be tested. All the 
important measurements for characterizing and quality analysis of the path are then performed 
automatically.

If the item under test is of unknown type, you can perform a “type determination” test, which 
determines all the properties of the item under test and lists them in a comprehensive report.

The “ANT-20 NEXT” software provides individual information about possible error causes and 
tips on how to clear the fault if problems or faults occur with the item under test or in the cabling.

Because the possible error causes usually depend on the item under test, you can add your 
own descriptions and notes to an existing “knowledge database”. The result is a complete, 
individually-tailored test system based on your level of experience. You can specify the scope 
of tests, the limit values that must be met and the expected values for, say, an alarm sensor test 
covering every existing type of device under test or measurement setup. These customized test 
applications can be saved and are then available at the click of a button the next time you use 
the “ANT-20 NEXT” software.
Introduction I-1
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2 About this operating manual

Overview

Chapter Contents

“Getting started” • This chapter describes how to start using the “ANT-20 NEXT” software on the 
ANT-20.

“Standard 
Applications”

• This chapter contains an overview of the pre-defined applications, separated 
into 2 Mbit/s signals and STM-1 signals:
– Monitoring an unknown 2 Mbit/s signal
– Analysis of a 2 Mbit/s line with unknown properties
– Commissioning a structured 2 Mbit/s communications line
– Commissioning a transparent 2 Mbit/s communications line

– Monitoring an unknown 34 Mbit/s signal
– Analysis of a 34 Mbit/s line with unknown properties
– Commissioning a transparent 34 Mbit/s communications line

– Monitoring/Analysis of unknown STM-1 SDH signals
– Analysis of unknown STM-1 lines
– Commissioning of STM-1 VC-4 communications lines
– Commissioning STM-1 radio links

“Operating” • This chapter is divided into two sections:
– Section 1 “For users in a hurry” describes how you can quickly start the 

“ANT-20 NEXT” software and perform one of the pre-defined test 
applications.

– Section 2 “For advanced users” describes operation in detail, particularly 
how to customize the standard applications to meet your specific 
requirements.

Table I-1 Operating manual contents
I-2 Introduction
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Getting started

1 Installing the ANT-20 NEXT software

If the “ANT-20 NEXT” software has not been installed on your ANT-20 yet, you can use the 
installation disks to install the software yourself.

To install the “ANT-20 NEXT” software

✓ The ANT-20 is switched on.
✓ All applications have been closed.

1. Insert the first installation disk into drive A.
2. Click on “Run” in the Start menu.

The “Run” window opens.
3. Type in “a:\setup.exe” in the text box.
4. Click on “OK”.

The “ANT-20 NEXT” software will be installed.
5. Follow the instructions given by the installation program.

Note: If possible, do not change the directory structure suggested by the installation program.

When installation is complete the Start menu will contain the menu item “ANT-20 NEXT/
ANT-20 NEXT” under “Programs”.

Fig. G-1 Start menu with “ANT-20 NEXT” software menu item
Getting started G-1
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A new program group with the following icon is also displayed:

Fig. G-2 “ANT-20 NEXT” software icon

Copying icons (shortcuts) to the desktop

⇒ Copy these icons to the ANT-20 desktop. 
You can start the “ANT-20 NEXT” software at any time by clicking on them.

Enabling the software

If you install the “ANT-20 NEXT” software on your ANT-20 yourself, you will need to enter the 
access code supplied with the software when you start the software for the first time. The dialog 
window for entering the access code will not be displayed the next time that you start the 
“ANT-20 NEXT” software.

The access code is supplied on a separate sheet included with the set of floppy disks. It has the 
format: “3035/95.40:XYZW”. You only need to enter the last four characters.
G-2 Getting started
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2 Backup

The “ANT-20 NEXT” software is stored in the following directories on the hard disk of the 
ANT-20:

Fig. G-3 Directory structure

You can generate or change the following files:

• Report files containing measurement results
(file name extensions: *.htc, *.htm, *.htr, *.hts)

• GIF files with company logos
(file name extension: *.gif)

• Text or HTML files that contain additions to the “knowledge database” 
(file name extensions: *.htm or *.txt).

• User-specific applications
(file name extensions: *.p1 for 2 Mbit/s applications, *.p3 for 34 Mbit/s applications or *.p2 for 
STM-1 applications)

The result files are stored in the “C:\ANT_NEXT\REPORT” directory by default. Changes in the 
“knowledge database” and the user-specific applications are stored in either the 
“C:\ANT_NEXT\APPL\...” directory.

Caution

Loss of data

Data can be lost if the hard disk is damaged.

⇒ Make regular backup copies of your data and files on external data media.
Getting started G-3
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Notes: 
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Standard Applications

1 Overview of standard applications

The standard applications are divided into three main groups:

• Applications for 2 Mbit/s signals
• Applications for 34 Mbit/s signals
• Applications for STM-1 signals

Each main group is linked to a separate “knowledge database”. The “knowledge database” 
contains information regarding error causes. You can add to and edit this information. Refer to 
Section 2.6 “Creating and customizing applications”, Page O-21 for details of how to do this.

Application name Notes

Applications for 2 Mbit/s signals

Monitoring 2 Mb/s, full check (approx. 
25 min)

Monitoring an unknown 2 Mbit/s signal Page SA-5

Line 2 Mb/s, unknown structure Analysis of a 2 Mbit/s line with unknown 
properties

Page SA-7

Line 2 Mb/s, PCM31CRC, terminated 
& re-timing, full test (approx. 25 min)

Commissioning a structured 2 Mbit/s 
communications line

Page SA-9

Line 2 Mb/s, transparent (unframed), 
no re-timing, full test (approx. 25 min)

Commissioning a transparent 2 Mbit/s 
communications line

Page SA-11

Applications for 34 Mbit/s signals

Monitoring 34 Mb/s, full check 
(approx. 25 min)

Monitoring an unknown 34 Mbit/s signal Page SA-13

Line 34 Mb/s, unknown structure Analysis of a 34 Mbit/s line with unknown 
properties

Page SA-15

Line 34 Mb/s, transparent 
(unframed), full test (approx. 25 min)

Commissioning a transparent 34 Mbit/s 
communications line

Page SA-17

Applications for STM-1 signals

Monitoring STM-1, full test (approx. 
25 min)

Monitoring/Analysis of unknown STM-1 SDH 
signals

Page SA-19

Line STM-1, unknown structure Analysis of unknown STM-1 lines Page SA-21

Line STM-1 VC-4, full check (approx. 
25 min)

Commissioning of STM-1 VC-4 communications 
lines

Page SA-23

Line STM-1, Digital Radio, full check 
(approx. 25 min)

Commissioning STM-1 radio links Page SA-25

Table SA-1 Overview of standard applications

Note: How to start the “ANT-20 NEXT” software, load an application and perform a 
diagnosis is described in the “Operating” Chapter:
• Section 1 “For users in a hurry”, Page O-1
• Section 2 “For advanced users”, Page O-9
Standard Applications SA-1
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2 Basic information on running applications

2.1 Measurement

There are two basic types of measurement:

• Monitoring (only involves ANT-20 RX)
• Line measurement with loop back at far end (involves TX and RX)

Each measurement takes place in two stages:

• Setting up the ANT-20 and determining the type of item under test
• Performing optional quality measurements such as long-term BERT, G.826/M.2100, intrinsic 

jitter test, MTJ, etc.

The generator section of the ANT-20 is not involved when the device is set for “Monitoring”. The 
item under test is typified using the received signal only. It is not possible to check whether the 
path being measured is clock or pattern transparent. It is also not possible to perform tolerance 
to jitter measurements and alarm sensor tests.

2.1.1 Typifying line parameters

Inputs and outputs

The ANT-20 automatically sets the correct TX outputs and RX inputs (balanced, coaxial or 
optical) during the first stage. This eliminates one of the most common causes of error in 
manual measurements. 

If the selected application allows measurements on PMP levels or measurements using the 
built-in equalizer of the ANT-20, these parameters will also be automatically set to their optimum 
settings.

Once the correct RX settings and a corresponding TX setting have been found for the ANT-20, 
a check is made to determine if the line is looped back at the far end. The program determines 
if the data transmitted by the ANT-20 generator can be transmitted to the ANT-20 generator.

Frame structure

The “ANT-20 NEXT” software automatically sets PCM31 or PCM31CRC frames for those line 
types where these frames are expected. An unframed signal is used for all subsequent 
measurements if it is detected that the line is transparent to signal structure.

Clock type

The clock type is an important criterion for typifying a 2 Mbit/s communications line.
A basic distinction is made between “clock-transparent” and “re-timing”. 

The “ANT-20 NEXT” software first determines the type of line. The ANT-20 is then automatically 
set correctly for subsequent measurements.

To determine the line type, the TX signal of the ANT-20 (setting: TX clock internal) is offset by 
10 ppm and the received clock signal measured. 

If the received clock is also offset by 10 ppm, the line is “clock-transparent”. 
If no offset is present in the received clock signal, the line operates with “re-timing”.
SA-2 Standard Applications
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If the line is “clock-transparent”

The transmission path accepts an externally superimposed clock signal and transmits it 
unchanged. 

If the line is “clock-transparent”, the internal clock of the ANT-20 will be used. A separate 
measurement of the “clock pulling range” is performed during the diagnosis to establish whether 
the line also performs correctly at the limits of the pulling range.

If the line is operated with “re-timing”

The line uses its own clock signal regardless of the incoming signal clock.

If the line operates with “re-timing”, the ANT-20 is automatically set to “Clock from RX”. This 
ensures that the line clock and the clock signal transmitted by the ANT-20 are identical.

This setting avoids sporadic bit slips (ANT-20: LSS) that occur as a result of slight differences in 
the two clock signals.

Measurement of the clock pulling range is unnecessary, since the clock is set by the item under 
test.

Checking known line properties

If the desired or required properties of the line to be tested are known (transparent or structured 
lines), a check is first made to see if these properties are present. The in-depth measurements 
(e.g. MTJ, G.826, jitter) are performed after this.

Note: The “ANT-20 NEXT” software sets itself automatically to the line type detected and 
performs all relevant measurements.

Example:

During commissioning of an “unstructured line”, the “ANT-20 NEXT” software determines that 
the line is, in fact, structured.

This leads to the “ANT-20 NEXT” software producing the diagnosis “Framed” which is 
evaluated as an error. Subsequent measurements are based on the knowledge that the line is 
structured. The alarm sensor tests such as LOS → RDI, which have no meaning for an 
unstructured line, are therefore performed.
Standard Applications SA-3
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2.1.2 Performing optional measurements

Once the line has been typified completely, you can make further measurements to test the line 
quality according to the selected application.

The following measurements can be performed (using 2 Mb/s as example):

• Alarm sensor tests for pattern-transparent lines:
– LOS → AIS_2 M 

• Alarm sensor and error sensor tests for framed lines:
– LOS → AIS_64k
– LOF → AIS_64K
– LOF → RDI (“Remote Defect”/D bit/remote alarm triggered on loss of frame)
– FAS error rate >1E-3 → RDI
– RDI → RDI (transparency test for a “Remote Defect”)
– CRC-4 errors → E bits

• Intrinsic jitter at the output of the item under test

• Tolerance to jitter of the item under test

• Clock pulling range (for clock-transparent systems only)

• G.826/M.2100 long-term quality monitoring
SA-4 Standard Applications
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3 Applications for 2 Mbit/s signals

Most of the applications described in the following sections are also available as “quick check” 
versions.

3.1 Monitoring 2 Mb/s, full check (approx. 25 min)

Monitoring an unknown 2 Mbit/s signal

Fig. SA-1 Monitoring an unknown 2 Mbit/s signal

Connecting the item under test

The balanced or coaxial sockets of the item under test are connected to input [12] or [14] of the 
receiver for the “Monitoring 2 Mb/s, full check (approx. 25 min)” application.

Tip: If the item under test is not equipped with a PMP socket, you can connect the ANT-20 to 
a “hot” line using a probe (e.g. TKD-1 from Wavetek Wandel Goltermann).

Measurement

The application automatically detects the correct impedance and receive level (ITU-T or PMP) 
and starts the line type test. This determines the type of signal present at the receiver input:

• PCM31
• PCM31CRC
• Unframed 
• AIS_2M
• Unknown (if none of the above signal types could be clearly determined, e.g. because a 

different bit rate was present)

The clock frequency deviation of the incoming signal is measured. The measured value will be 
displayed if it is more than ±2 ppm.
Standard Applications SA-5
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If widely differing values are measured during three consecutive measurements, the diagnosis 
“Clock variable” is given. A diagnosis of “Clock variable” is an indication of synchronization 
problems. It may also indicate that a signal with a different bit rate or with a line code that does 
not correspond to HDB3 is present.

If a framed signal is detected, the current alarm situation will also be displayed:

• RDI (remote alarm, D bit)
• AIS_64k (i.e. framed signal with all ones in all payload channels)

Optional measurements

The following optional measurements allow further analysis of the quality of the incoming signal:

• Intrinsic jitter
• G.826 analysis for a period of 15 minutes 

– Analysis is referred to the FAS or CRC/E bit for framed signals with unknown payload (in-
service).

– Analysis is referred to the payload if a “PRBS15 payload” or “framed pattern PRBS15” is 
detected for unframed or PCM31CRC signals (out of service).

Alarms and error messages

If alarms occur or limit values are exceeded, a brief explanatory text is displayed in the “Possible 
Causes” field of the “ANT-20 NEXT - [Application]” window. A more detailed cause description 
and further information can be displayed if you double-click on the item of interest and the 
necessary information is stored in the “knowledge database”. You can add to or edit the texts 
stored in the “knowledge database”.
Also refer to Section 2.6.2 “Customizing an application”, Page O-22 for more information.

Adaptations

You can adapt the “Monitoring 2 Mb/s, full check (approx. 25 min)” application to suit your 
special requirements. This applies to the jitter and G.826 tests in particular. You can also 
change the limit values and gate times. 
Also refer to Section 2.6 “Creating and customizing applications”, Page O-21 for more 
information.
SA-6 Standard Applications
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3.2 Line 2 Mb/s, unknown structure

Analysis of a 2 Mbit/s line with unknown properties

Fig. SA-2 Analysis of a 2 Mbit/s line with unknown properties

Special features

If the properties of the line are unknown, a measurement to determine the type of line present 
is performed first. After this, measurements that apply to the type of line detected will be 
performed.

A “Pass/Fail” assessment will not be made from the properties that are detected, since the 
nominal line type is unknown.

Connecting the item under test

The balanced or coaxial output and input sockets of the item under test are connected to input 
[12] or [14] of the receiver (RX) and output [13] or [15] of the generator (TX) for the 
“Line 2 Mb/s, unknown structure” application.

Measurement

The application initially starts a measurement to typify the line. The following properties of the 
line are investigated:

• Is the line also suitable for unframed signals (transparent)?
• Is the line only suitable for framed (structured) PCM31or PCM31CRC signals (Framed, 

CRC-4)?
• Does the line transmit the received signal without imposing its own clock signal, i.e. is the 

line clock-transparent (re-timing)?
• Is there a loop back for the payload data at the far end of the line (continuity)?
• Is the line terminated for FAS?

After this, measurements that apply to the type of line detected will be performed:

• Do the alarm and error sensors work properly?
• Is the frequency of the incoming signal (when there is no RX signal) within ±2 ppm of the 

nominal clock frequency (AIS frequency)?
• Are the intrinsic jitter and tolerance to jitter within the limit values?
• Does a clock-transparent line also operate properly at the limits of the clock pulling range?
• Are any errors detected during a G.826 / M.2100 analysis (long term measurement)?
Standard Applications SA-7
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Alarms and error messages

If alarms occur or limit values are exceeded, a brief explanatory text is displayed in the “Possible 
Causes” field of the “ANT-20 NEXT - [Application]” window. A more detailed cause description 
and further information can be displayed if you double-click on the item of interest and the 
necessary information is stored in the “knowledge database”. You can add to or edit the texts 
stored in the “knowledge database”.
Also refer to Section 2.6.2 “Customizing an application”, Page O-22 for more information.

Adaptations

You can adapt the “Line 2 Mb/s, unknown structure” application to suit your special 
requirements. This applies to the jitter and G.826 tests in particular. You can also change the 
limit values and gate times. 
Also refer to Section 2.6 “Creating and customizing applications”, Page O-21 for more 
information.
SA-8 Standard Applications
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3.3 Line 2 Mb/s, PCM31CRC, terminated & re-timing, full test (approx. 25 min)

Commissioning a structured 2 Mbit/s communications line

Use the “Line 2 Mb/s, PCM31CRC, terminated & re-timing, full test (approx. 25 min)” application 
if you intend to commission a structured and terminated 2 Mbit/s PCM31CRC line.

Special features

If the desired or required properties of the line to be tested are known (transparent or structured 
lines), a check is first made to see if these properties are present. The in-depth measurements 
(e.g. MTJ, G.826, jitter) are performed after this.

Connecting the item under test

The balanced or coaxial output and input sockets of the item under test are connected to input 
[12] or [14] of the receiver (RX) and output [13] or [15] of the generator (TX) for the “Line 2 Mb/
s, PCM31CRC, terminated & re-timing, full test (approx. 25 min)” application.

Measurement

The following typical line parameters are expected:

Note: The clock pulling range is not measured, since “re-timing” is used. All measurements 
are performed with the “ANT-20 TX clock from RX” setting.

The following measurements are then performed:

Typical line parameter Explanation

Frames Yes

CRC Yes

Re-timing Yes

Termination for FAS and CRC FAS and CRC errors are not returned to the ANT-20 via the loop 
back.

CRC-4 / E bit detection Every inserted CRC-4 error must be acknowledged by an E bit 
error.

Table SA-2 Expected line type parameters

Test Explanation

Alarm sensor test LOS → AIS_64k The line must return a framed all ones signal if no signal is present 
at the input.

Alarm sensor test LOS → RDI The line must return a RDI (D bit) if no signal is present at the 
input.

Alarm sensor test RDI → RDI RDI must pass through transparently.

Signal delay < 22 ms “round trip” Corresponds to an “end-to-end” delay of 11 ms

Intrinsic jitter HP1 (10 Hz/100 kHz): 
< 1.1 UIpp

Intrinsic jitter measured with HP1 (10 Hz high-pass filter)

Table SA-3 Measurements performed
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Alarms and error messages

If alarms occur or limit values are exceeded, a brief explanatory text is displayed in the “Possible 
Causes” field of the “ANT-20 NEXT - [Application]” window. A more detailed cause description 
and further information can be displayed if you double-click on the item of interest and the 
necessary information is stored in the “knowledge database”. You can add to or edit the texts 
stored in the “knowledge database”.
Also refer to Section 2.6.2 “Customizing an application”, Page O-22 for more information.

Adaptations

You can adapt the “Line 2 Mb/s, PCM31CRC, terminated & re-timing, full test (approx. 25 min)” 
application to suit your special requirements. This applies in particular to the jitter and G.826 
tests and also to the “re-timing” property that is either expected or to be eliminated. You can also 
change the limit values and gate times. 
Also refer to Section 2.6 “Creating and customizing applications”, Page O-21 for more 
information.

Intrinsic jitter HP2 (18 kHz/100 kHz): 
< 0.2 UIpp

Intrinsic jitter measured with HP2 (18 kHz high-pass filter)

MTJ The requirements of ITU-T G.823 must be met.

M.2100/G.826 No errors may occur for measurement times of up to 24 hours.
Test signal: PCM31CRC with PRBS15
A G.826 “Out of Service” analysis is performed (default gate time: 
15 min).

Test Explanation

Table SA-3 Measurements performed (continued)
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3.4 Line 2 Mb/s, transparent (unframed), no re-timing, full test (approx. 25 min)

Commissioning a transparent 2 Mbit/s communications line

Use the “Line 2 Mb/s, transparent (unframed), no re-timing, full test (approx. 25 min)” 
application if you intend to commission an unstructured 2 Mbit/s line. The term unstructured 
means that the line can transport any unframed or framed 2 Mbit/s signals.

Special features

If the desired or required properties of the line to be tested are known (transparent or structured 
lines), a check is first made to see if these properties are present. The in-depth measurements 
(e.g. MTJ, G.826, jitter) are performed after this.

Connecting the item under test

The balanced or coaxial output and input sockets of the item under test are connected to input 
[12] or [14] of the receiver (RX) and output [13] or [15] of the generator (TX) for the “Line 2 Mb/
s, transparent (unframed), no re-timing, full test (approx. 25 min)” application.

Measurement

All the relevant tests are performed using an unframed PRBS15 test pattern.

The following typical line parameters are expected:

The following measurements are then performed:

Typical line parameter Explanation

Frames No

CRC Not applicable

Re-timing No

Clock pulling range > ±50 ppm All measurements are performed with the “ANT-20 TX clock from 
RX” setting.

Termination for FAS and CRC Not applicable

CRC-4 / E bit detection Not applicable

Table SA-4 Expected line type parameters

Test Explanation

Alarm sensor test LOS → AIS_2M The line must return an unframed all ones signal if no signal is 
present at the input.

Signal delay < 22 ms “round trip” Corresponds to an “end-to-end” delay of 11 ms

Intrinsic jitter HP1 (10 Hz/100 kHz): 
< 1.1 UIpp

Intrinsic jitter measured with HP1 (10 Hz high-pass filter)

Table SA-5 Measurements performed
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Alarms and error messages

If alarms occur or limit values are exceeded, a brief explanatory text is displayed in the “Possible 
Causes” field of the “ANT-20 NEXT - [Application]” window. A more detailed cause description 
and further information can be displayed if you double-click on the item of interest and the 
necessary information is stored in the “knowledge database”. You can add to or edit the texts 
stored in the “knowledge database”.
Also refer to Section 2.6.2 “Customizing an application”, Page O-22 for more information.

Adaptations

You can adapt the “Line 2 Mb/s, transparent (unframed), no re-timing, full test (approx. 25 min)” 
application to suit your special requirements. This applies in particular to the jitter and G.826 
tests and also to the “re-timing” property that is either expected or to be eliminated. You can also 
change the limit values and gate times. 
Also refer to Section 2.6 “Creating and customizing applications”, Page O-21 for more 
information.

Intrinsic jitter HP2 (18 kHz/100 kHz): 
< 0.2 UIpp

Intrinsic jitter measured with HP2 (18 kHz high-pass filter)

MTJ The requirements of ITU-T G.823 must be met.

M.2100/G.826 No errors may occur for measurement times of up to 24 hours.
Test signal: PRBS15
A G.826 “Out of Service” analysis is performed.

Test Explanation

Table SA-5 Measurements performed (continued)
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4 Applications for 34 Mbit/s signals

Most of the applications described in the following sections are also available as “quick check” 
versions.

4.1 Monitoring 34 Mb/s, full check (approx. 25 min)

Monitoring an unknown 34 Mbit/s signal

Fig. SA-3 Monitoring an unknown 34 Mbit/s signal

Connecting the item under test

The coaxial socket of the item under test is connected to input [12] of the receiver for the 
“Monitoring 34 Mb/s, full check (approx. 25 min)” application.

Measurement

The application automatically detects the correct impedance and receive level (ITU-T or PMP) 
and starts the line type test. This determines the type of signal present at the receiver input:

• Framed
• Unframed
• AIS_34M
• Unknown (if none of the above signal types could be clearly determined, e.g. because a 

different bit rate was present)

The clock frequency deviation of the incoming signal is measured. The measured value will be 
displayed if it is more than ±2 ppm.
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If widely differing values are measured during three consecutive measurements, the diagnosis 
“Clock variable” is given. A diagnosis of “Clock variable” is an indication of synchronization 
problems. It may also indicate that a signal with a different bit rate or with a line code that does 
not correspond to HDB3 is present.

If a framed signal is detected, the current alarm situation will also be displayed:

• RDI (remote alarm, D bit)

Optional measurements

The following optional measurements allow further analysis of the quality of the incoming signal:

• Intrinsic jitter
• G.826 analysis for a period of 15 minutes 

– The analysis is referred to the FAS for framed signals with unknown payload (in-service).

Alarms and error messages

If alarms occur or limit values are exceeded, a brief explanatory text is displayed in the “Possible 
Causes” field of the “ANT-20 NEXT - [Application]” window. A more detailed cause description 
and further information can be displayed if you double-click on the item of interest and the 
necessary information is stored in the “knowledge database”. You can add to or edit the texts 
stored in the “knowledge database”.
Also refer to Section 2.6.2 “Customizing an application”, Page O-22 for more information.

Adaptations

You can adapt the “Monitoring 34 Mb/s, full check (approx. 25 min)” application to suit your 
special requirements. This applies to the jitter and G.826 tests in particular. You can also 
change the limit values and gate times. 
Also refer to Section 2.6 “Creating and customizing applications”, Page O-21 for more 
information.
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4.2 Line 34 Mb/s, unknown structure

Analysis of a 34 Mbit/s line with unknown properties

Fig. SA-4 Analysis of a 34 Mbit/s line with unknown properties

Special features

If the properties of the line are unknown, a measurement to determine the type of line present 
is performed first. After this, measurements that apply to the type of line detected will be 
performed.

A “Pass/Fail” assessment will not be made from the properties that are detected, since the 
nominal line type is unknown.

Connecting the item under test

The balanced or coaxial output and input sockets of the item under test are connected to input 
[14] of the receiver (RX) and output [15] of the generator (TX) for the “Line 34 Mb/s, unknown 
structure” application.

Measurement

The application initially starts a measurement to typify the line. The following properties of the 
line are investigated:

• Is the line also suitable for unframed signals (transparent)?
• Is the line only suitable for framed signals (structured)?
• Is there a loop back for the payload data at the far end of the line (continuity)?
• Is the line terminated for FAS?

After this, measurements that apply to the type of line detected will be performed:

• Do the alarm and error sensors work properly?
• Is the frequency of the incoming signal (when there is no RX signal) within ±2 ppm of the 

nominal clock frequency (AIS frequency)?
• Are the intrinsic jitter and tolerance to jitter within the limit values?
• Does a clock-transparent line also operate properly at the limits of the clock pulling range?
• Are any errors detected during a G.826 / M.2100 analysis (long term measurement)?
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Alarms and error messages

If alarms occur or limit values are exceeded, a brief explanatory text is displayed in the “Possible 
Causes” field of the “ANT-20 NEXT - [Application]” window.
A more detailed cause description and further information can be displayed if you double-click 
on the item of interest and the necessary information is stored in the “knowledge database”. You 
can add to or edit the texts stored in the “knowledge database”.
Also refer to Section 2.6.2 “Customizing an application”, Page O-22 for more information.

Adaptations

You can adapt the “Line 34 Mb/s, unknown structure” application to suit your special 
requirements. This applies to the jitter and G.826 tests in particular. You can also change the 
limit values and gate times. 
Also refer to Section 2.6 “Creating and customizing applications”, Page O-21 for more 
information.
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4.3 Line 34 Mb/s, transparent (unframed), full test (approx. 25 min)

Commissioning a transparent 34 Mbit/s communications line

Use the “Line 34 Mb/s, transparent (unframed), full test (approx. 25 min)” application if you want 
to commission a transparent 34 Mbit/s line. 

Special features

If the desired or required properties of the line to be tested are known (transparent or structured 
lines), a check is first made to see if these properties are present. The in-depth measurements 
(e.g. MTJ, G.826, jitter) are performed after this.

Connecting the item under test

The coaxial output and input sockets of the item under test are connected to input [14] of the 
receiver (RX) and output [15] of the generator (TX) for the “Line 34 Mb/s, transparent 
(unframed), full test (approx. 25 min)” application.

Measurement

The following typical line parameters are expected:

The following measurements are then performed:

Typical line parameter Explanation

Frames no

Table SA-6 Expected line type parameters

Test Explanation

Alarm sensor test LOS → AIS The line must return an all ones signal if no signal is present at 
the input.

Signal delay < 22 ms “round trip” Corresponds to an “end-to-end” delay of 11 ms

Intrinsic jitter HP1 (10 Hz/100 kHz): 
< 1.1 UIpp

Intrinsic jitter measured with HP1 (10 Hz high-pass filter)

Intrinsic jitter HP2 (18 kHz/100 kHz): 
< 0.2 UIpp

Intrinsic jitter measured with HP2 (18 kHz high-pass filter)

MTJ The requirements of ITU-T G.823 must be met.

M.2100/G.826 No errors may occur for measurement times of up to 24 hours.
Test signal: PCM31CRC with PRBS15
A G.826 “Out of Service” analysis is performed (default gate time: 
15 min).

Table SA-7 Measurements performed
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Alarms and error messages

If alarms occur or limit values are exceeded, a brief explanatory text is displayed in the “Possible 
Causes” field of the “ANT-20 NEXT - [Application]” window.
A more detailed cause description and further information can be displayed if you double-click 
on the item of interest and the necessary information is stored in the “knowledge database”. You 
can add to or edit the texts stored in the “knowledge database”.
Also refer to Section 2.6.2 “Customizing an application”, Page O-22 for more information.

Adaptations

You can adapt the “Line 34 Mb/s, transparent (unframed), full test (approx. 25 min)” application 
to suit your special requirements. This applies to the jitter and G.826 tests in particular, as well 
as to the “re-timing” characteristic that is expected or to be excluded. You can also change the 
limit values and gate times. 
Also refer to Section 2.6 “Creating and customizing applications”, Page O-21 for more 
information.
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5 Applications for STM-1

Most of the applications described in the following sections are also available as “quick check” 
versions.

5.1 Monitoring STM-1, full test (approx. 25 min)

Monitoring/Analysis of unknown STM-1 SDH signals

Fig. SA-5 Monitoring/Analysis of unknown STM-1 SDH signals

Connecting the item under test

The electrical or optical output socket of the item under test is connected to input [16] or [17] of 
the receiver (RX) for the “Monitoring STM-1, full check (approx. 25 min)” application.

Note: If you want to feed high power (> 0 dBm) optical signals into socket [17], use the 
(optional) built-in power splitter of the ANT-20 or another attenuator to reduce the level.

Measurement

The “ANT-20 NEXT” software automatically detects whether the optical or the electrical input is 
being used. The equalizer is switched in for electrical receive levels (ITU-T or PMP) to 
compensate for any possible line attenuation. 

The application then starts a measurement to typify the line by establishing the signal type 
present at the receiver:

• STM-1 with AU-4 structure
• STM-1 with VC-12 structure
• Unknown (if a LOF-STM alarm is detected, e.g. because of an incorrect bit rate)

The clock frequency deviation of the incoming signal is measured. The measured value will be 
displayed if it is more than ±2 ppm.
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If widely differing values are measured during three consecutive measurements, the diagnosis 
“Clock variable” is given. A diagnosis of “Clock variable” is an indication of synchronization 
problems. It may also indicate that a signal with a different bit rate or with a line code that does 
not correspond to CMI is present.

If a standard SDH signal is detected, the current SDH alarm situation for the AU-4 and HP levels 
will be displayed:

• AU-LOP
• AU-AIS
• MS-AIS
• MS-RDI
• HP-UNEQ
• HP-TIM
• HP-PLM
• HP-RDI

The AU pointer movements will be read out and evaluated for 20 seconds.

Optional measurements

The following optional measurements allow further analysis of the quality of the incoming signal:

• Intrinsic jitter
• G.826 analysis for a period of 15 minutes

– Analysis is referred to “B3/HP-REI” errors for signals with unknown AU-4 payload (in-
service).

– Analysis is referred to the payload if a “PRBS23 Bulk Payload” is detected (out of 
service).

Alarms and error messages

If alarms occur or limit values are exceeded, a brief explanatory text is displayed in the “Possible 
Causes” field of the “ANT-20 NEXT - [Application]” window. A more detailed cause description 
and further information can be displayed if you double-click on the item of interest and the 
necessary information is stored in the “knowledge database”. You can add to or edit the texts 
stored in the “knowledge database”.
Also refer to Section 2.6.2 “Customizing an application”, Page O-22 for more information.

Adaptations

You can adapt the “Monitoring STM-1, full check (approx. 25 min)” application to suit your 
special requirements. This applies to the jitter and G.826 tests in particular. You can also 
change the limit values and gate times. 
Also refer to Section 2.6 “Creating and customizing applications”, Page O-21 for more 
information.
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5.2 Line STM-1, unknown structure

Analysis of unknown STM-1 lines

Fig. SA-6 Analysis of unknown STM-1 lines

Special features

If the properties of the line are unknown, a measurement to determine the type of line present 
is performed first. After this, measurements that apply to the type of line detected will be 
performed.

A “Pass/Fail” assessment will not be made from the properties that are detected, since the 
nominal line type is unknown.

Connecting the item under test

The optical or electrical output and input sockets of the item under test are connected to input 
[17] or [14] of the receiver (RX) and output [18] or [15] of the generator (TX) for the 
“Line STM-1, unknown structure” application.

Measurement

The application initially starts a measurement to typify the line. The following properties of the 
line are investigated:

• Which interface is being used (optical or electrical)?
• Does the line have an AU-4 structure?
• Does the line have a VC-12 structure?
• Is there a loop back for the VC-4 path at the far end of the line (continuity)?

After this, measurements that apply to the type of line detected will be performed:

• Do the alarm and error sensors for the “Regenerator Section” and “Multiplexer Section” 
levels operate properly?

• Do the alarm and error sensors for the “Path” level operate properly?
• Are the intrinsic jitter and tolerance to jitter within the limit values?
• Are any errors detected during a G.826 / M.2100 analysis (long term measurement)?
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Alarms and error messages

If alarms occur or limit values are exceeded, a brief explanatory text is displayed in the “Possible 
Causes” field of the “ANT-20 NEXT - [Application]” window. A more detailed cause description 
and further information can be displayed if you double-click on the item of interest and the 
necessary information is stored in the “knowledge database”. You can add to or edit the texts 
stored in the “knowledge database”.
Also refer to Section 2.6.2 “Customizing an application”, Page O-22 for more information.

Adaptations

You can adapt the “Line STM-1, unknown structure” application to suit your special 
requirements. This applies to the jitter and G.826 tests in particular. You can also change the 
limit values and gate times. 
Also refer to Section 2.6 “Creating and customizing applications”, Page O-21 for more 
information.
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5.3 Line STM-1 VC-4, full check (approx. 25 min)

Commissioning of STM-1 VC-4 communications lines

Use the “Line STM-1 VC-4, full check (approx. 25 min)” application if you intend to commission 
a STM-1 line with VC-4 containers.

If the desired or required properties of the line to be tested are known, a check is first made to 
see if these properties are present. The in-depth measurements (e.g. MTJ, G.826, jitter) are 
performed after this.

Connecting the item under test

The optical or electrical output and input sockets of the item under test are connected to input 
[17] or [14] of the receiver (RX) and output [18] or [15] of the generator (TX) for the 
“Line STM-1 VC-4, full check (approx. 25 min)” application.

Measurement

The following typical line parameters are expected:

The following alarm sensor tests are then performed:

Typical line parameter Explanation

Input / Output Optical or electrical

AU-4 structure Yes

VC-12 structure No

Termination for the VC-4 path No

Loop back at VC-4 level Yes

Table SA-8 Expected typical line parameters

Alarm sensor test

LOS → MS-RDI & AU-AIS

LOF-STM → MS-RDI & AU-AIS

RS-TIM → MS-RDI & AU-AIS

MS-AIS → MS-RDI & AU-AIS

AU-LOP → AU-AIS

AU-AIS → AU-AIS

MS-RDI → No alarm

HP-UNEQ → HP UNEQ

MS-REI → No alarm

B2 → MS-REI

Table SA-9 Alarm sensor tests
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After this, measurements that apply to the type of line detected will be performed:

Alarms and error messages

If alarms occur or limit values are exceeded, a brief explanatory text is displayed in the “Possible 
Causes” field of the “ANT-20 NEXT - [Application]” window. A more detailed cause description 
and further information can be displayed if you double-click on the item of interest and the 
necessary information is stored in the “knowledge database”. You can add to or edit the texts 
stored in the “knowledge database”.
Also refer to Section 2.6.2 “Customizing an application”, Page O-22 for more information.

Adaptations

You can adapt the “Line STM-1 VC-4, full check (approx. 25 min)” application to suit your 
special requirements. This applies to the jitter and G.826 tests in particular. You can also 
change the limit values and gate times. 
Also refer to Section 2.6 “Creating and customizing applications”, Page O-21 for more 
information.

B2 error rate 2E-4 → No alarm

B2 error rate 3E-4 → MS-RDI and AU-AIS

Insertion of single B3 errors → Same number of B3 errors
(VC-4 loop back)

Test Explanation

Alarm and error sensor test “Regenerator Section” / “Multiplexer Section” levels

Alarm and error sensor test “Path” level

Intrinsic jitter Intrinsic jitter measurement

MTJ The requirements of ITU-T G.823 must be met.

M.2100/G.826 Performance measurements based on the “PRBS 23 Bulk” test 
pattern (Out of Service)

Table SA-10 Measurements performed

Alarm sensor test

Table SA-9 Alarm sensor tests (continued)
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5.4 Line STM-1, Digital Radio, full check (approx. 25 min)

Commissioning STM-1 radio links

Use the “Line STM-1, Digital Radio, full check (approx. 25 min)” application if you want to 
commission a STM-1 digital radio link.

If the desired or required properties of the line to be tested are known, a check is first made to 
see if these properties are present. The in-depth measurements (e.g. MTJ, G.826, jitter) are 
performed after this.

Connecting the item under test

The optical or electrical output and input sockets of the item under test are connected to input 
[17] or [14] of the receiver (RX) and output [18] or [15] of the generator (TX) for the 
“Line STM-1, Digital Radio, full check (approx. 25 min)” application.

Measurement

The following typical line parameters are expected:

The following alarm sensor tests are then performed:

Typical line parameter Explanation

Input / Output Optical or electrical

AU-4 structure Yes

VC-12 structure No

Termination for the VC-4 path No

Loop back at VC-4 level Yes

Table SA-11 Expected typical line parameters

Alarm sensor test

LOS → AU-AIS

LOF-STM → AU-AIS

RS-TIM → AU-AIS

MS-AIS → AU-AIS

AU-LOP → AU-AIS

AU-AIS → AU-AIS

Table SA-12 Alarm sensor tests
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After this, measurements that apply to the type of line detected will be performed:

Alarms and error messages

If alarms occur or limit values are exceeded, a brief explanatory text is displayed in the “Possible 
Causes” field of the “ANT-20 NEXT - [Application]” window. A more detailed cause description 
and further information can be displayed if you double-click on the item of interest and the 
necessary information is stored in the “knowledge database”. You can add to or edit the texts 
stored in the “knowledge database”.
Also refer to Section 2.6.2 “Customizing an application”, Page O-22 for more information.

Adaptations

You can adapt the “Line STM-1, Digital Radio, full check (approx. 25 min)” application to suit 
your special requirements. This applies to the jitter and G.826 tests in particular. You can also 
change the limit values and gate times. 
Also refer to Section 2.6 “Creating and customizing applications”, Page O-21 for more 
information.

Test Explanation

Intrinsic jitter Intrinsic jitter measurement

MTJ The requirements of ITU-T G.823 must be met.

M.2100/G.826 Performance measurements based on the “PRBS 23 Bulk” test 
pattern (Out of Service)

Table SA-13 Measurements performed
SA-26 Standard Applications



ANT-20/ANT-20E ANT-20 NEXT
Operating

“Operating” is divided into two sections:

• Section 1 “For users in a hurry” describes how you can use the “ANT-20 NEXT” software to 
perform a pre-defined measurement application.

• Section 2 “For advanced users” describes the software functions in detail. This section is 
aimed at users who want to customize, edit or expand the “ANT-20 NEXT” software to meet 
their specific requirements.

1 For users in a hurry

1.1 Connecting the items under test

⇒ Connect the items under test according to the line type to the following sockets on the 
ANT-20:

Socket Description

[12] Electrical input (balanced)

[13] Electrical output (balanced)

[14] Electrical input (encoded)
1.5 to 156 Mbit/s

[15] Electrical output (encoded)
1.5 to 156 Mbit/s

[16] Electrical input STM-1/STM-4
622 Mbit/s

[17] Optical input OC-1/-3/-12/STM-1/STM-4
1310/1550 nm

[18] Optical output OC-1/-3/-12/STM-1/STM-4
1310/1550 nm

Table O-1 Connecting sockets on the ANT-20
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1.2 Starting the ANT-20 NEXT software

The first time that you start the “ANT-20 NEXT” software on the ANT-20, you must enter the 
access code. See under “Starting the ANT-20 NEXT software for the first time” for details.

The “ANT-20 NEXT” software is started as described under “Starting the ANT-20 NEXT 
software” if the access code has already been entered.

Note: • You cannot run the “ANT-20” application (interactive user interface) and the 
“ANT-20 NEXT” software at the same time. You also cannot start more than 
one “ANT-20 NEXT” software application at a time.

• Please note that you can use the Windows Start menu settings to select 
whether the ANT-20 interactive user interface or a selected “ANT-20 NEXT” 
software application is started automatically when you start the ANT-20.

• You can test the full functions of the “ANT-20 NEXT” software for a period of 
thirty days without entering the access code.
This evaluation period starts when the software is started for the first time. If 
you want the evaluation period to start later, use the “Abort” button rather than 
the “Start” button to exit from the “ANT-20 NEXT Welcome” window. The “Reg-
ister” button opens a window for entering the access code. 
This entry window is not displayed again when the “ANT-20 NEXT” software is 
started again.
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Starting the ANT-20 NEXT software for the first time

✓ Any applications that were running have been closed.

1. Click on “Programs/ANT-20 NEXT/ANT-20 NEXT” in the start menu.
The “ANT-20 NEXT Welcome” window opens.

Fig. O-1 “ANT-20 NEXT Welcome” window

2. Click on the “Start” button if you want to try out the “ANT-20 NEXT” software.
This activates the 30-day evaluation period. Please note the information on page O-2.
– or –
Click on the “Register” button if you have already purchased the “ANT-20 NEXT” software.
The “ANT-20 NEXT Registration” window opens.

Fig. O-2 “ANT-20 NEXT Registration” window

3. Enter the access code.
The access code is supplied on a separate sheet delivered with the set of floppy disks. The 
access code has the format: “3035/95.40:WXYZ”. Enter the last four characters only.

4. Click on the “OK” button.
The software is now registered and the “ANT-20 NEXT Configuration” window opens 
(see Fig. O-3).

5. Continue with step 2 under “Starting the ANT-20 NEXT software”.
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Starting the ANT-20 NEXT software

✓ Any applications that were running have been closed.

1. Click on “Programs/ANT-20 NEXT/ANT-20 NEXT” in the start menu.
The “ANT-20 NEXT Configuration” window opens.

Fig. O-3 “ANT-20 NEXT Configuration” window

2. Select the group of applications required (i.e. the bit rate).
3. Select the language required.
4. Click on the “OK” button.

The “ANT-20 NEXT - [Application]” window opens with the last application that was 
selected. The name of the last application that was loaded is shown in the title bar, e.g.: 
“ANT-20 NEXT - Line 2 Mb/s PCM31CRC, terminated & re-timing, quick test (< 5 min)”.

Fig. O-4 “ANT-20 NEXT - [Application]” window

Note: The green buttons indicate the standard path through the various windows. Normally, 
the next step is to click on the green button to perform an action. For this reason only 
one button in each window will be green.

There are two ways to start an application:

1: Start the last application selected

⇒ Click on the “Start” button.
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2: Load and start a new application

1. Click the “Load” button under the “Application” menu in the “ANT-20 NEXT - [Application]” 
window.
The “Load Application” window opens.

Fig. O-5 “Load Application” window

2. Select the desired application from the “Applications” field.
3. Click on the “Load” button.

The selected application is loaded and the “Load Application” window closes.
The “ANT-20 NEXT - [Application]” window is displayed.

4. Click on the “Start” button under “Application”.

Note: You can find more information on starting the “ANT-20 NEXT” software in 
Section 2.1, Page O-9.

Entering user parameters

The “Define User Parameters” window opens when you start an application.

Fig. O-6 “Define User Parameters” window

5. Enter your user parameters in this window.
6. Click on “OK”.

The diagnosis now starts.

Note: The entry in the text box (next to Unit Under Test) is used as the header for the 
automatically generated test report.
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Indicators during diagnosis

Fig. O-7 “ANT-20 NEXT - [Application]” window during a diagnosis

• The “Start” button (green) changes to “Abort” (red).
• Buttons and menus that cannot be used are grayed out.
• “Running” is shown next to “Diagnosis”.
• The LEDs may flash green, red or yellow during certain phases of the diagnosis.
• The results of the diagnostic tests made are shown in the text box under “Diagnosis”.
• The possible causes for a diagnostic result are shown in the “Possible Causes” field on 

completion of all measurements.
• The type of line detected is shown in the lower part of the window.

Indicators after diagnosis

Fig. O-8 “ANT-20 NEXT - [Application]” window with “Save Report - [Application name]” window after 
diagnosis

Note: The text displayed in the text box is color-coded:
Black: Detected property of the unit under test
Green: Measurements assessed as “OK” and results that correspond with 

expectations
Red: Incorrect measurements or results that contradict expectations
Yellow: Warnings
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Saving the report

1. Click on the “Save” button in the “Save Report - [Application name]” window.
The “Save Report” window opens.

Fig. O-9 “Save Report” window

2. Enter a name for the report in the “File Name:” text box: File name extension “.htm”.
3. Click on “Save”.

The report is saved in HTML format under the name you entered. The “Save Report” window 
and the “Save Report - [Application name]” window close.

• The “Save Report - [Application name]” window displays:
– PASS (green) if the diagnosis showed no faults
– FAIL (red) if faults were detected by the diagnosis
– ABORT (yellow) if the diagnosis was terminated prematurely

• “Ready” or “Abort” is shown next to “Diagnosis” in the “ANT-20 NEXT - [Application]” 
window:
– Status LED green No faults diagnosed
– Status LED red Diagnosis detected faults
– Status LED yellow Warning

• Alarms
– Alarm LED red An alarm occurred during diagnosis.
– Alarm LED green No alarms occurred.
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1.3 Evaluating and recording the diagnosis

Viewing the report

1. Click on the “View” button in the “ANT-20 NEXT - [Application]” window.
An external HTML viewer window opens with the report of the diagnosis.

Fig. O-10 Diagnosis report display

2. To view further details in the report, click on the scroll bars and / or the context-sensitive text 
in the lower part of the report.

Printing the report

1. Click on the “Print Preview” menu item in the “File” menu.
A preview of the printout is displayed.

2. Click on “Print”.
The currently-loaded page of the report will be printed out.

Note: Text in the HTML viewer is color-coded:
Black: Instrument setup and measurements assessed as “OK” and results 

that correspond with expectations
Red: Incorrect measurements or results that contradict expectations
Yellow: Warnings
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2 For advanced users

2.1 Starting the software

The “ANT-20 NEXT” software can be started in different ways.

2.1.1 Starting the software from the Start menu

⇒ Click on the “Programs/ANT-20 NEXT/ANT-20 NEXT” menu item in the Start menu
The “ANT-20 NEXT” software will load with a standard application.
Each time the “ANT-20 NEXT” software is started again, it will load the application that was 
selected when it was last used.

Fig. O-11 Starting the software from the Start menu

2.1.2 Starting the software from a desktop icon

You can place an icon (shortcut) on the desktop when you install the “ANT-20 NEXT” software.

Fig. O-12 Starting the software from an icon (shortcut)

✓ The “NEXT Release 2.00” icon is shown on the desktop.

⇒ Double click on the “NEXT Release 2.00” icon on the desktop.
The “ANT-20 NEXT” software will start.
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2.2 Loading an application

You must load a pre-defined application or an application you created yourself in order to 
perform a diagnosis.

The following sections describe the various methods of selecting and loading an application.

Note: You cannot start more than one application of the “ANT-20 NEXT” software at a time.

2.2.1 Automatically loading the last application selected

The “ANT-20 NEXT” software always starts by loading the application that was in use when it 
was last shut down. This means that you can always continue working from where you left off 
last time. Also refer to Section 2.1, Page O-9.

2.2.2 Loading an application with the Load button

1. Click on the “Load” button under “Application” in the “ANT-20 NEXT - [Application]” window.
The “Load Application” window opens.

Fig. O-13 Loading an application

2. In the “Applications” field, click on the application that you want to load.
3. Click on the “Load” button.

The “Load Application” window will close.
The selected application will load.
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2.2.3 Loading an application with the Load menu item in the Application menu

Fig. O-14 “Application” menu

1. Click on the “Load” menu item in the “Application” menu of the 
“ANT-20 NEXT - [Application]” window.
The “Load Application” window opens.

2. Under “Applications”, click on the application that you want to load.
3. Click on the “Load” button.

The “Load Application” window will close.
The selected application will load.

2.2.4 Opening one of the last five applications loaded

Fig. O-15 “Application” menu with display of the last five applications loaded

⇒ Click on one of the items under “Edit” (up to 5) in the “Application” menu of the 
“ANT-20 NEXT - [Application]” window, e.g. “Line 2 Mb/s, PCM31CRC, terminated & re-
timing, full test (approx. 25 min)”.
The selected application will load.
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2.2.5 Creating a new icon (shortcut)

You can create a shortcut on the Desktop to the software so that the software will always start 
with a specific application loaded when you click on the icon.

1. Create a shortcut to the “ANT-20 NEXT” software on the Desktop.
The icon is displayed on the Desktop.

Fig. O-16 Starting the software from an icon (shortcut)

2. Click on the newly created icon with the right-hand mouse button.
A context menu opens.

3. Click on the “Properties” menu item in the context menu
The “Properties ...” window opens.

4. Click on the “Shortcut” tab.
5. Enter the program name in the “Target:” text field and then enter the following parameters:

“-kb” followed by the bit rate designation (“pdh2”, “pdh34”, “sdh155”)
“-lang” followed by the language designation (“Deutsch”, “English”)
“-appl” followed by the name of the parameter file
Example:
“c:\ant_next\next.exe -kb pdh2 -lang english -appl c:\ant_next\appl\kb_2m\unfr_2m.p1”.

6. Click on “OK”.
7. Double click on the shortcut icon on the Desktop.

The “ANT-20 NEXT” software will start with the specified application.

You can use this method to create an icon (shortcut) for each application that you require.

The shortcut can be created using the Windows Explorer if you are using an ANT-20 equipped 
with a touchscreen.

Editing the shortcut name

1. Click on the shortcut icon.
The icon is highlighted.

2. Click again on the highlighted icon.
The name can now be edited.

3. Type in a new name.
4. Press the “Enter” key.
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2.3 Starting the diagnosis

Once you have selected an application, you can start the diagnosis.

⇒ Click on the “Start” button.

Fig. O-17 Starting the diagnosis

The “Define User Parameters” window opens.

Fig. O-18 “Define User Parameters” window for entering user data

Note: The designation entered in the first line for the UUT (Unit Under Test) is used as the 
heading for the automatically generated test report.

All the boxes in the “Define User Parameters” window can be edited. You can make entries to 
suit your own requirements.

1. Enter the designation of the unit under test in the first text box to the right of “UUT”.
2. You can enter the name of the person performing the test, the customer’s name and other 

details in the remaining text boxes.
3. Click on “OK”.

The diagnosis starts.
The label for the “Start” button (green) in the “ANT-20 NEXT - [Application]” window 
changes to “Abort” (red).
All buttons and menus are disabled except the “Abort” button.

“! Simulation !” is displayed in the “Define User Parameters” window

This message indicates that the “ANT-20 NEXT” software cannot communicate with the 
measurement computer of the ANT-20. This should only occur with the demonstration version 
of the software.

⇒ If this message is displayed during normal operation of the full version, restart Windows.
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2.4 Aborting a diagnosis

You can stop any diagnosis that is in progress.

⇒ Click on the “Abort” button.

Fig. O-19 Aborting a diagnosis

What happens when you click on the “Abort” button

• Any measurement in progress will be completed.
• The “Save Report - [Application name]” window shows the message “ABORT” (yellow) to 

indicate that the diagnosis was stopped prematurely.
• “Abort” is shown next to “Diagnosis” in the “ANT-20 NEXT - [Application]” window.
• The status LED next to “Diagnosis” will turn yellow.

Note: Since some long term measurements are performed during the diagnosis, it may take 
some time before the diagnosis stops.
O-14 Operating



ANT-20/ANT-20E ANT-20 NEXT
2.5 Reporting the results

The “ANT-20 NEXT” software can generate high-quality measurement reports as HTML files. 
This section describes how to use these reports.

2.5.1 Viewing the report

⇒ Click on the “View” menu item in the “Report” menu in the “ANT-20 NEXT - [Application]” 
window.

Fig. O-20 “Report” menu

– or –

⇒ Click on the “View” button in the “ANT-20 NEXT - [Application]” window.

Fig. O-21 “View” button in the “ANT-20 NEXT - [Application]” window

The “ANT-20 NEXT” software starts a separate HTML viewer that displays the report.

Note: Some parts of the user interface may change color briefly while the HTML viewer is 
loading.

Placing the HTML viewer on top

⇒ Use the taskbar to place the HTML viewer on top if it is obscured by another window.
– or –
Press the “ALT” and “TAB” keys simultaneously as often as is necessary to restore the 
HTML viewer to the top of the user interface.
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2.5.1.1 Report structure

Fig. O-22 Report display in HTML viewer (report header)

Every report is made up from the following sections:

• Header
• Line Parameters
• Assessment
• Measurements
• Test Status
• Settings (details page)
• Detailed Results (details page)
• Possible Causes (details page)
• Links

Header

The report header contains the name of the application used and the text that you entered in the 
“Define User Parameters” window (see Section 2.3, Page O-13).

Line Parameters

“Line Parameters” lists the main characteristics of the path. e.g.: 

• structure-transparent / not structure-transparent
• clock-transparent / not clock-transparent
• etc.

Assessment

The “Assessment” section contains the diagnoses that are displayed if they are “true” 
(applicable). For example, the diagnosis “AIS-2M” might appear here. However, if no AIS is 
detected, then the diagnosis “AIS-2M” will not be shown. 
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Measurements

The “Measurements” section lists the diagnoses that are linked to specific measurements:

• Intrinsic jitter
• MTJ
• Pulling range
• etc.

The measurements are always assessed as either “Pass” or “Fail”.

⇒ To see the individual results, click on the “Detailed results” link at the end of the document.

Test Status

The result of the diagnosis is shown under “Test Status”: PASS, !PASS (= warning), FAIL or 
ABORT. 

Settings (details page)

The “Settings” section lists all the settings that the ANT-20 used to perform the measurements.

These settings are important when you want to revert to interactive operation of the ANT-20 to 
investigate specific problems. You can read the required settings directly from this section and 
thus avoid making errors when setting the ANT-20.

Detailed Results (details page)

The results of all the measurements performed are listed in detail under “Detailed Results”.

Possible Causes (details page)

The causes of the errors are listed under “Possible Causes”.

Links

“Links” are inserted at the end of each page to keep the report as clear as possible. The “Links” 
provide shortcuts to further details pages. These details pages are displayed when you click on 
a “Link”.

Fig. O-23 Report display in the HTML viewer (end of report) with links to other pages in the report
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The following links are provided:

Display colors

• Settings Displays the instrument settings
• Detailed results Displays the detailed result of the measurements
• Possible Causes Displays the possible causes of an error
• Summary (only on the details pages) Displays the summary

Text color Explanation

Black • Explanatory text and headings
• The diagnosis has been assessed as a “PASS” by the “ANT-20 NEXT” 

software. 
Meaning when the line type is being determined: No contradiction of the 
expected parameters was detected.
Meaning when a measurement is made: No limit values were exceeded.

Yellow 
(with preceding 
exclamation mark)

Warning

Red 
(with preceding 
exclamation mark)

The diagnosis has been assessed as a “FAIL” by the “ANT-20 NEXT” software. 
Meaning when the line type is being determined: Contradictions of the expected 
parameters were detected.
Meaning when a measurement is made: Limit values were exceeded.

Underlined text “Links” to other HTML pages (details pages) that contain details about the 
individual measurements and diagnoses.

Table O-2 Text colors in the report
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2.5.2 Saving the report

A report is generated every time a diagnosis is started. The last report that was created will be 
overwritten by the new report.

To save a report so that you can evaluate it later, proceed as follows:

1. Click on the “Save” menu item in the “Report” menu in the “ANT-20 NEXT - [Application]” 
window.
– or –
Click on the “Save” button.
The “Save Report” window opens.

Fig. O-24 “Save Report” window

2. Select the destination where the report is to be saved under “Directories:” (normally the 
“C:\ANT_NEXT\REPORT” directory).

3. Enter a name for the report in the “File Name:” text box (file name extension *.htm).
4. Click on the “Save” button.

The report will be saved under the specified name.

Each time you save a report, four files are generated with the following file name extensions:

• name.htc
• name.htm
• name.htr
• name.hts

The “logo.gif” file for the company logo must also be saved in the same directory.

Note: If you want to copy a report from the ANT-20 to another PC, you must copy all four files 
and the “logo.gif” file. If you do not copy all the files, the error message “Broken Links” 
will be displayed when you try to view the report.
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2.5.3 Loading a report

To display a report for evaluation, proceed as follows:

1. Click on the “Load” menu item in the “Report” menu in the “ANT-20 NEXT - [Application]” 
window.
– or –
Click on the “Load” button (under “Report”).
The “Load Report” window opens.

Fig. O-25 “Load Report” window

2. Under “Directories:”, select the location where the report has been stored.
3. In the “File Name:” text box, enter the name of the report that you want to view (file name 

extension *.htm).
4. Click on the “Load” button.

The report with the name you entered will be displayed.

2.5.4 Printing the report

To print out a report, proceed as follows:

✓ A printer is connected to socket [5] PRINTER of the ANT-20 and an appropriate printer driver 
is installed.

✓ The report that you want to print out is displayed in the HTML viewer.

1. Click on the “Print Preview” item in the “File” menu in the HTML viewer.
Once the report has been formatted, the “Preview Form” window opens.

2. Click on the “Print ...” button.
The currently-loaded page of the report will be printed out.

2.5.5 Adding a logo to the report

The company logo for Wavetek Wandel Goltermann is shown in the top right hand corner of the 
report. You can replace this logo with your own company logo:

• Format: GIF
• Size: < 256 x 150 pixels
• File name: LOGO.GIF

1. Generate a file (LOGO.GIF) containing your company logo.
2. Save the file in the “C:\ANT_NEXT” directory.

The existing logo will be overwritten.
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2.6 Creating and customizing applications

An application is defined by the following information:

• The required line characteristics
• The weighting or evaluation of the possible diagnoses
• The descriptions of the possible causes of problems
• The sets of parameters (measurement times, tolerance limits, etc.) for the individual 

measurements

The following sections describe how you can create and customize a new application.

2.6.1 Creating a new application

1. Click on the “New” menu item in the “Application” menu in the “ANT-20 NEXT - [Application]” 
window.
The “Define New Application” window opens.

Fig. O-26 “Define New Application” window

2. Enter a description (up to 255 characters) for the new application in the text box in the 
“Application” field.

3. Select the type of application: “Monitoring” or “Line (TX/RX)”.
4. Select the expected characteristics under “Expected Signal Type”.
5. Select the optional measurements that you want to perform (“Optional Measurements”).
6. Click on the “OK” button.

Note: A description of the application must be entered, otherwise an error message will be 
displayed when you exit from the window.

The next section tells you how to customize the new application to meet your requirements.
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2.6.2 Customizing an application

You can customize applications at two levels:

• Customize basic parameters (Basics)
• Customize the Expert setup (Details)

– Customize diagnostic evaluations
– Customize description of possible error cause (Possible Causes)
– Set the measurement parameters (gate times, etc.)
– Deactivate measurements

Customizing the basic parameters (Basics)

✓ The application that you want to customize is loaded.

1. Click on the “Edit” menu item in the “Application” menu in the “ANT-20 NEXT - [Application]” 
window.
The “Edit Basics - [Application name]” window opens.

Fig. O-27 “Edit Basics - [Application name]” window

2. Adjust the settings in this window to meet your requirements.
3. Click on the “OK” button.

Customizing the Expert setup (Details)

⇒ Click on the“ExpertMode” menu item in the “Administration” menu of the 
“ANT-20 NEXT - [Application]” window.
The item is marked with a check (✔).
Four buttons are now shown in the “Edit Basics - [Application name]” window; these can be 
used for customizing the details of the applications.

Fig. O-28 “Administration” menu
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Customizing diagnostic evaluation

✓ The application that you want to customize is loaded.
✓ Expert mode is activated.

1. Click on the “Edit” menu item in the “Application” menu in the “ANT-20 NEXT - [Application]” 
window.
The “Edit Basics - [Application name]” window opens.

Fig. O-29 “Edit Basics - [Application name]” window

2. Click on the “Diagnosis” button in the “Edit Basics - [Application name]” window.
The “Edit Diagnosis - [Application name]” window opens.

Fig. O-30 “Edit Diagnosis - [Application name]” window

3. Click on the item in the “Diagnosis” field the evaluation of which you want to customize.
4. Change the settings for the selected item in the lower part of the window.
5. Repeat steps 2 and 3 for the other items that you want to customize.
6. Click on the “Save” button.

The “Edit Diagnosis - [Application name]” window will close.
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Customizing and linking the Possible Causes (description of possible error cause)

A description of possible error cause (Possible Causes) is displayed in the following windows:

• “ANT-20 NEXT - [Application]” window in the “Possible Causes” field
• “Explain Diagnosis” window in the “Description” field
• HTML viewer (report)

The description of a possible error cause is in two parts: A single line briefly describing the 
cause and a longer text explaining the cause in more detail. The latter can also include 
comments such as advice on making repairs, etc. These texts are termed the “knowledge 
database”.

The single line description is displayed in the “Possible Causes” field in the 
“ANT-20 NEXT - [Application]” window.

The longer text is displayed in the “Description” field of the “Explain Diagnosis” window.

Fig. O-31 Display of error cause

The single line description is saved by the “ANT-20 NEXT” software. To save longer texts, you 
must create and save a separate file (file name extension *.txt or *.htm). You can create a file for 
each error cause.

The following section describes how to enter the single line of text, how to select the text file and 
the link to a diagnosis.

To customize an error cause

✓ The application that you want to customize is loaded.
✓ Expert mode is activated.
✓ The text files with the longer descriptions of the error causes have been saved.

1. Click on the “Edit” menu item in the “Application” menu in the “ANT-20 NEXT - [Application]” 
window.
The “Edit Basics - [Application name]” window opens.

2. Click on the “Causes” button in the “Edit Basics - [Application name]” window.
The “Manage Causes - [Application name]” window opens.
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Fig. O-32 “Manage Causes - [Application name]” window

The single line descriptions of all available error causes are listed in the “Possible Causes” field 
in the “Manage Causes - [Application name]” window.

3. Click on the item in the “Possible Causes” field that you want to customize.
4. To remove the item, click on the “Cut” button.

– or –
To edit the item, click on the “Edit” button.
– or –
To add a new item, click on the “Add” button.
If you click on “Edit” or “Add”, the “Edit Causes - [Application name]” window opens.

Fig. O-33 “Edit Causes - [Application name]” window

5. In the “Diagnosis” field, select the diagnosis to which the possible error cause is to be linked.
6. Enter a suitable single line of text that describes the error cause in the “Cause” text box.
7. Click on the “Browse” button.

The “Select File” window opens.
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Fig. O-34 “Select File” window

8. In the “File Name:” text box, enter the name of the text file (*.txt) or the HTML file (*.htm) in 
which the longer text with a more exact error cause description is saved.

9. Click on the “Select” button.
The file name of the text file will now be displayed in the “File Name (*.htm or *.txt)” field of 
the “Edit Causes - [Application name]” window.

10.Click on “OK”.
The “Manage Causes - [Application name]” window opens again.

11.Select another item in the “Manage Causes - [Application name]” window.
– or –
Click on the “Save” button.
The changes you made will be saved.

Setting parameters

The parameters define the framework for the individual measurements. The measurement 
intervals, limit values and similar items are set in this way.

To set a parameter

✓ The application that you want to customize is loaded.
✓ Expert mode is activated.

1. Click on the “Edit” menu item in the “Application” menu in the “ANT-20 NEXT - [Application]” 
window.
The “Edit Basics - [Application name]” window opens.

2. Click on the “Parameters” button in the “Edit Basics - [Application name]” window.
The “Select Measurement Parameters - [Application name]” window opens.

Fig. O-35 “Select Measurement Parameters - [Application name]” window

3. Click on the parameter that you want to modify in the 
“Select Measurement Parameters - [Application name]” window.

4. Click on the “Edit” button.
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The “Edit Measurement Parameter” window opens.

Fig. O-36 “Edit Measurement Parameter” window

5. Enter the value required in the text box.
The units for the parameter are shown after the text box. The number of possible decimal 
places is indicated by the default value which is displayed.

6. Click on the “OK” button.
The “Select Measurement Parameters - [Application name]” window opens again.

7. Select another item in the “Select Measurement Parameters - [Application name]” window.
– or –
Click on the “OK” button.

Deactivating measurements

Some measurements have no meaning under certain circumstances, or they may be 
undesirable for other reasons (e.g. length of time required). Some measurements can therefore 
be deactivated.

To deactivate or activate measurements

✓ The application that you want to customize is loaded.
✓ Expert mode is activated.

1. Click on the “Edit” menu item in the “Application” menu in the “ANT-20 NEXT - [Application]” 
window.
The “Edit Basics - [Application name]” window opens.

2. Click on the “Checks” button in the “Edit Basics - [Application name]” window.
The “Select Optional Measurements - [Application name]” window opens. All the 
measurements that can be deactivated are listed here.

Fig. O-37 “Select Optional Measurements - [Application name]” window
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3. Click on the measurements that you want to deactivate.
The check (✔) preceding the items is cleared.
– or –
Click on a deactivated measurement.
The measurement is activated and a check (✔) appears in front of the item.

4. Click on the “OK” button.
The “Select Optional Measurements - [Application name]” window closes.

2.6.3 Saving a (new) application

1. Click on the “Save As” menu item in the “Application” menu in the 
“ANT-20 NEXT - [Application]” window.
The “Save Application” window opens.

Fig. O-38 “Save Application” window

2. Under “Directories:”, select the path under which the new application is to be saved.
3. Enter the file name for the new application (max. 8 characters) in the “File Name:” text box.
4. Click on the “Save” button.

The new application will be saved under the file name you entered.

2.6.4 Saving an (edited) application

⇒ Click on the “Save” menu item in the “Application” menu in the 
“ANT-20 NEXT - [Application]” window.
The application will be saved under its existing file name.

Note: Applications that have been provided by Wavetek Wandel Goltermann cannot be 
overwritten. In such cases, the “Save” menu item has the same effect as the “Save As” 
menu item, i.e. you will be prompted to enter a new file name.
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